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TrueTerm EPOC The multilingual dictionary

Introduction

What is TrueTerm EPOC?

Using the dictionaries of the TrueTerm series you can look
up words as easily as in usual dictionaries. TrueTerm is an
application program that stands out not only due to the
quality of the integrable dictionaries but also due to its
portability to various platforms. For example, TrueTerm runs
on PCs under Windows 95/98 and under NT. Special
versions are available for handheld computers such as
PalmOS and Windows CE.

With the network version TrueTermNet you can for instance
create and manage a company's terminology for translations
in local networks. With TrueTerm you guarantee that all
employees have access to the same dictionary data and that
all employees can add their own data to the common
database.
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Installation and deinstallation

Installation

Before installing TrueTerm EPOC

This version of TrueTerm has been exclusively developed
for Palmtop computers with the operating system EPOC32
(for example Psion Series 5). On Palmtop computers with the
operating system EPOC16 (for example Psion Series 3)
TrueTerm EPOC does not work.

In order to install TrueTerm EPOC you need a desktop
computer running Windows 95/98/NT

Installation

The installation is realized in two steps:

1. The installation of the TrueTerm EPOC data from the
CD-ROM on your desktop computer (CD-ROM >
Desktop computer).

2. From a desktop computer onto the handheld computer
(Desktop computer > Psion).

CD-ROM > Desktop computer

* Insert the TrueTerm EPOC CD-ROM in the CD-ROM
drive of your desktop computer.

* In the Windows Explorer select the CD-ROM drive and
start the program INSTALL.EXE.

+ Please now follow the instructions on the screen.

During the installation on your desktop computer you have
the possibility to choose any languages (= dictionaries) you
want to have copied on your PC first. In order to use the
dictionaries on your handheld computer you always need the
TrueTerm EPOC program files.
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Desktop computer > Psion

Note:

» Connect your desktop computer with the handheld
computer and check if the connection is able to
work.

* Inthe menu Start — Program files — TrueTerm
EPOC select the menu item Installation
TrueTerm EPOC Program files and afterwards
choose any dictionaries you want to install.

» After that, please follow the instructions of the
installation program.

The transmission of the program to the handheld computer
can take up to 20 minutes, depending on the size and the
selected transfer rate.

Deinstallation

In this case you have to carry out a separate deinstallation
on your handheld computer as well as on your desktop
computer.

Psion

Change to the System on the handheld computer by
closing all applications on it and pressing the keyboard
shortcut Ctrl + S. Select Add/remove and then the
program TrueTerm.

Here you may delete the current dictionary files by
marking them and by tapping the Delete button with
the stylus. It might be useful to deinstall dictionaries if
you want to install other dictionaries and if the memory
is not sufficient for it.

To delete TrueTerm EPOC completely, you have to
delete additionally the program files. For this, proceed
in accordance with the dictionaries.

Desktop computer

» Click on Start — Control panel — Software on your
desktop computer and select the program
TrueTerm EPOC. Then click with the mouse on
the Delete button.

* Then please follow the instructions of the
deinstallation program.

TrueTerm EPOC
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Functions of TrueTerm EPOC

Start TrueTerm EPOC

Touch the menu item Extras in the Extrasbar of the
handheld computer and start the TrueTerm program.

Alternatively you can start TrueTerm EPOC by the directory
of the internal drive (Disk C). In that case, tap the drive letter
in the title bar (caption) with the stylus. After that, touch twice
and in quick succession the TrueTerm icon. Select now, by
another double touch, the dictionary you want to activate.
You will recognize the dictionary by the file extension .dic. If
you don’t want to use the stylus, you can use the cursor keys
in order to select and the Enter key in order to confirm.

Another possibility to start TrueTerm EPOC is to change to
the directory System\Apps\TrueTerm. There tap twice the
TrueTerm.app icon with the stylus or select this icon with the
cursor keys. Confirm with Enter.

Select dictionaries

With TrueTerm EPOC you can install several dictionaries on
your handheld computer, for example spanish and german.
This means you need only one program to use different
dictionaries.

To call up the dictionary, please select the corresponding
dictionary in the dialog box Open file after the start of the
TrueTerm EPOC program. You call up the dialog box by
touching the Open button:

=

Alternatively you can activate the menu of TrueTerm EPOC
with the Menu key or the command icon Menu. There select
File and the menu item Open dictionary or press the

keyboard shortcut Ctrl + O. In both cases the following
dialog box appears:

6 ¢ Functions of TrueTerm EPOC TrueTerm EPOC
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If you use a memory
card (drive D) besides
the internal disk (C)
you can also save
data on it.

Qpen file

Name German-English-German.dic

<« TrueTerm L g

Disk c

| Durchsuchen...| | Abbrechen | | oK |
Sig+D

In the Name box you can select a dictionary. If the desired
dictionary is not displayed, you can select a dictionary by
touching the arrows on the right and on the left of the name
box.

If you want to change to another folder and/or another disk,
either tap Folder or Disk to select a folder or a disk. You
can call up Name, Folder and Disk by the cursor keys as
well. You can see the whole choice within the input fields by
one short tap with the stylus on the input field.

You can see the whole directory of a disk by one short tap on
the Browse button or by pressing the keyboard shortcut Ctrl
+D.

Confirm the selection of the dictionary with OK. The
dictionary is being loaded and the program window of
TrueTerm EPOC reappears.

If you want to go back to another dictionary, repeat this
process for the desired language.

Look up a keyword

If you want to look up a word, please enter it by the help of
the keyboard. For that, position the cursor in the Keyword
input field. You can position the cursor by tapping the
keyboard shortcut Ctrl + K or Esc or with a touch on the
input field with the stylus. As soon as you enter the first
letters, the program browses through the keyword list and
narrows down the possible translations.

For example, if you enter the word set, you will get the
following Dictionary entry:

Fapmmrd <Cli+E > [2]] [2] oictanery antry <Ctrise-
2t set M
— 1. {preparadmecc] fertig
ST Z (lime) Teshge gl festgeleat =
SEniCe A {spants - dannk ) SatE =
Sandce change i (pames - cardte) Spil r =
SELEME B flealsy Salk
CEGCAME SEed B (charmond] einfasser
E T ihmbled dmckEr —_—
==t fire bo A {sunl urtergehen
A ) & (kavr) einlegen =3
SetE ane's accouns L 10, foblectks ! leqen: setoem ;
seftle ane's bil hd 11, fiwe) festleger, festselzen (7

TrueTerm EPOC
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In the Dictionary entry field the meanings of a word are
explained in different meaning fields. If a word has many
different meanings, a scroll bar is displayed on the right of
the field, that you can move with the stylus. In order to
change to the Dictionary entry field you can also press the
keyboard shortcut Ctrl + H and then move the cursor with
the help of the cursor keys.

After you have entered a word, this word is marked in the
keyword list and you can browse through the keyword list
with the cursor keys of the keyboard. Meanwhile, the text in
the Keyword input field remains the same.

With the scroll bar on the right of the keyword list you can
also browse through this list. The symbols on the left of a
keyword have the following meanings:

- currently activated keyword of the original
dictionary

g new keyword, defined by the user

o keyword that has been changed by the user

If you want to enter a new keyword immediately after you
have entered a word in the Keyword input field, press the
keyboard shortcut Ctrl + K or Esc to go back to the
Keyword input field. By that you delete the entry in the
Keyword field at the same time.

With the Enter key you mark the input in the Keyword input
field. As soon as you have marked the input, just enter the
next keyword and the text inside the input field will be typed
over.

The simplest way to find the right translation of a term in the
Dictionary entry field is to press and keep pressed the
Control key and to tap the word in the Dictionary entry with
the stylus. The chosen word is transferred to the Keyword
entry field and the search function is started. Here, the
search direction can possibly be changed. TrueTerm EPOC
automatically saves every word you call in this way and
confirm with the Enter key in the so-called History list so
that you can look it up again later (see: History lists).

To change the size of the keyword list, touch the bar
between the keyword list and the dictionary entry field until it
becomes black. After that you can move the bar to the left or
to the right in order to make room in one of the lists. To
change the screen see also: Show toolbar.

8 ¢ Functions of TrueTerm EPOC TrueTerm EPOC
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History lists

There are two so-called history lists in which your selected
keywords are saved. These lists enable you to go back to a
word you want to look up again any time.

Each keyword you enter in the Keyword input field and
confirm with the Enter key is automatically saved in the
history list containing the entered keywords. The keyword
that is marked in the keyword list is also transferred to the
history list by touching and confirming with the Enter key.
Keywords in the Dictionary entry field that you mark and
call up by the Control key and by touching them
simultaneously with the stylus (and then comfirm with Enter)
are saved in a separate history list.

If you want to look up at a word again, you have to call up the
history list by the

button. The left button refers to the words you have entered
in the Keyword input field. You can also press the keyboard
shortcut Ctrl + | if the cursor is in the keyword list:

Keyward <Ol =k [=] E[ Dichinary aniry <Chi+H=
fimiagia

=

. 1. {mikror) Spiegebid n
aenlibs = L {resemblance) Ebenbild r
Chess = A (remadationt Image ©
chesk 4. (ming] Bild r; Varstellung 1

LLIRLIALIIL

clags

NOLUS Bk ping
'||,.l'_.|E'
wateriagged

impassioned

[+]>]

the right button concerns the words you have called up in the
Dictionary entry field:

Eepword <Cin=k= E = | Diclionary eniry oCis+H-

|.':r
truffe bittes =l Probe ¢
frurmp acetc = =
fruni; muUmps ~ Rorahisnen; sich bemiiber =
st il et =
ruth Zaamell Iten

-
try ar — Maschsal
It concephon -
hamibl= i 3
haminler L ]

Here you can also press the keyboard shortcut Ctrl + | if the
cursor is in the dictionary entry field.

Within the respective history list you select a word by
touching it. You can also use the Enter key in order to have
the marked entry displayed.

TrueTerm EPOC

Functions of TrueTerm EPOC « 9



You can browse the history lists either by moving the scroll
bar up and down or by touching the arrow keys below the
scroll bar or by using the arrow keys of the keyboard.

If you don’t need the entries of the history lists any longer
you can delete them. With the Delete key you delete a
marked entry and with the keyboard shortcut Ctrl + Del you
delete all the entries of a list.

Please notice that the history list of the entered keywords
refers to a specific language, that is, if you change to another
search direction you change to another history list as well.

Change search direction

The change to another search direction is done by the
buttons with the language icons of the toolbar.

Alternatively you can use the keyboard shortcut Ctrl + W in
order to change to another search direction.

If you want to activate another dictionary, please see
chapter: Select dictionaries.

The toolbar

With the buttons of the toolbar you can carry out the most
important functions of the dictionary:

= | |Open and select dictionaries in order to activate
dictionaries (see: Select dictionaries).

Calling up dictionary settings: This way you fix the
dictionary files you want to load and you set the font
of the keyword list

(see: Dictionary settings).

[ | |Add new keywords
(see: Add new keywords).

Ll Save new keywords and changed dictionary entries
(see: Add new keywords or Edit dictionary
entries).

B | | Select search direction
(see: Change search direction).

€ Show or blank changed user-specific entries
(see: Edit dictionary entries).

A Change current font in the Dictionary entry field
(see: Edit dictionary entries).

10 ¢ Functions of TrueTerm EPOC TrueTerm EPOC
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Show only new or changed keywords and dictionary

entries
(see: Change dictionary display).

To blank the toolbar, please see chapter: Show toolbar.

Close dictionary

In order to close TrueTerm EPOC, touch once the
TrueTerm icon of the toolbar. Afterwards a dialog box is
displayed, in which you have to confirm the command to
close the application program by a touch on the Close file

button.

TrueTerm EPOC Functions of TrueTerm EPOC « 11



Tools and options

Set dictionary options

The menu item Tools offers two possible Options to be set.
If you have selected the option Open last edited dictionary
at the program start, the dictionary used last is
automatically displayed.

However, if you want to start TrueTerm EPOC with another
dictionary without undoing the selected option, you may start
the desired dictionary by the directory of the internal drive as
well. To this end, tap with the stylus on the drive letter in the
title bar (caption). After that, touch twice in quick succession
the icon TrueTerm. Then select the dictionary you want to
activate by another double touch. You will recognize the
dictionary by the file extension .dic. If you don’t want to use
the stylus, you can use the cursor keys for selection and the
Enter key for confirmation.

If you have deactivated the option Open last edited
dictionary at the program start, you will be automatically
asked for the desired dictionary in the dialog box Open file at
the program start of TrueTerm EPOC.

Show or blank graphic symbols

You can show or blank the graphic symbols (see: Look up a
keyword) on the left of the keyword in the keyword list.
These symbols indicate if a keyword is active, if a keyword
has been changed or if a new keyword has been added. For
that, select the menu item Options within the Tools menu. If
you want to activate the graphic symbols, make a tick. In
order to deactivate the graphic symbols, you have to delete
the tick.

Show toolbar

On the toolbar of TrueTerm EPOC you can easily execute all
important functions by buttons.

12 « Tools and options
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TrueTermn
s
[

o | 5a
= | A

However, if you prefer to use the place taken by the toolbar
to enlarge the dictionary entry field, you can blank the
toolbar: Select the menu item Show toolbar in the Tools
menu. Only if you make a tick, the toolbar will be displayed.
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Dictionary functions

Edit dictionary entries

To edit an dictionary entry, position the cursor in the
Dictionary entry field or press the keyboard shortcut Ctrl +
H. Now you can also use the cursor keys to move inside the
dictionary entry and to make changes in particular places or
to add new text. Furthermore, you can cut , copy and paste
marked words or passages by the Edit menu. Never forget to
save the changes by using the Save button

=

or by the menu call Edit — Dictionary entry — save. You will
recognize the changed entry by a circle in front of the
keyword within the keyword list.

Within a dictionary entry you can also mark passages and
highlight them by special formattings. To this end, you have
to position the cursor in the Dictionary entry field, as
mentioned above, and there you have to mark the word or
passage by the stylus or by pressing the Shift key + Cursor
key. You can call up the options to set the current font or
format the current paragraph in the Dictionary entry field by
touching the Font/Paragraph button

A

or by calling up the menu item Edit — Dictionary entry —
current font . The following dialog box Set font: is
presented:

Schriftart festiegen

Schriftart I 5anau’ues|

Sehriftart Times New Roman

Schrirtaradi JC R T
Fott

Hursiv
Untersirichen Abbruct e
YVorschau proverbs E

Here you can select the font (Arial, Times New Roman,
Courier), type size and further options of the current cursor

14 « Dictionary functions
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position or a marked word or passage within the Dictionary
entry field. On the card Other you will find:

Schriftart festlegen i

Schriftart| Sonstiges |

Textfarbe o Schwarz HW»
Durchgestrichen

Druckposition Standard

|mm1
Vorschau Arial

Here you can choose the text color in shades of grey and
further options. You can select the individual menu items by
touching the arrows on the right and on the left of the list box.
To see the whole choice tap in the list box with the stylus.
Confirm your choice with OK. After that, the dictionary entry
is being formatted. Here as well, don’t forget to save all
changes as mentioned above.

Changed dictionary entries are marked by a circle in the
keyword list. If you want to blank these changes in the
display touch the

button of the toolbar or call up the Edit — Dictionary entry —
original entry menu. In this way you can redisplay your
changes. Please notice that changes of formatting cannot be
displayed or blanked.

Add new keywords
You can add a new keyword by touching the
&

button of the toolbar or by calling up the menu item new in
the Edit — Keyword menu. The following dialog box with an
input line appears:

New keyword...

[Abbrechen] | ok |

Now you can enter the new keyword in the input line.
Confirm with OK. You’ll see the new keyword sorted in
alphabetical order within the keyword list and marked by a
plus. The cursor is blinking in the Dictionary entry field and
you can immediately start to enter the translation. Please
save your entry by touching the

TrueTerm EPOC Dictionary functions ¢ 15
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button of the toolbar or by selecting the menu item save in
the Edit — Dictionary entry menu or else by pressing the
keyboard shortcut Ctrl + S.

To change the entered keyword call up the Edit — Keyword
menu and select the menu item rename. A dialog box with
an input line appears. There you’ll find the marked keyword
to be changed. Now you can change it. Confirm the change
by OK.

To delete the entered keyword you also have to call up the
Edit — Keyword menu and then to select the menu item
delete. A dialog box appears and asks if you really want to
delete the word. Confirm the deletion by OK.

You cannot delete keywords of the dictionaries supplied by
TrueTerm EPOC or keywords you have changed.

Change dictionary display

As soon as you have added a new keyword or modified a
dictionary entry you will recognize the new keywords by a
plus in front of the keyword. You will recognize changed
keywords by a circle in front of the keyword.

If you want to show only the new or changed keywords and
dictionary entries you have to touch the Dictionary
Application Symbol of the toolbar:

TrueTerm now shows the user-defined entries:

Eapwond <Cin == E E Dichanary aniry =l
picreit praverh
= saying: Sprickmart n, Sinnspruch
#Imags n, L=hr=pruch m
o —]
* QIAETEs = =
+ st = -
* [rueTesmn = ]
& &
¥ L]

If you want to go back to the standard display you have to
tap the Dictionary Application Symbol in the toolbar with
the stylus:

16 e Dictionary functions TrueTerm EPOC
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Now, all data are shown together, that is you have access to
the original data and the user-specific data. Both kinds of
data are included on the keyword list.

Eepword <Cin=k= E E Diconary aniry oCis+H-

[H =T ] proverh

= saying: Sprichkeart n, Sinnspouch
prognetar n, Lehrspruch m

osE
prokein
Pz

[ —
R

# priveerhs
priveide for
provdde with
prerAsion

&
v

La]>]

Create new dictionaries

To create a new dictionary, call up the File menu and there
select the menu item New dictionary. Automatically you get
to the dialog box Dictionary settings where you can select
the desired options. For further details please see:
Dictionary settings. Now you can create a new dictionary
that suits your requirements, for example english-spanish
and english-german as two search directions in one
dictionary. Confirm the settings in this dialog box with OK
and save the new dictionary by calling up the File menu and
selecting the menu item Save dictionary.. The dialog box
Save as appears:

Speichern unter

Name]
Crdner TrueTerm

Disk C

[ Durchsuchen,..| | Abbrechen | | oK |
Sirg+D

Here please enter a name for the new dictionary and if
necessary the folder and the disk, too. Be careful that you
use .dic as file extension. Confirm the storing by OK. Now
you can use and edit this dictionary as the other dictionaries.

Dictionary settings

The settings are necessary

* to create a new dictionary
(see: Create new dictionaries);

» to change particular options for the dictionaries you
use and

« if options that have been set in dictionaries are lost.

TrueTerm EPOC
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The easiest way to call up the Dictionary settings is to
touch the

button of the toolbar. You can also use the menu call File —
Dictionary settings or the keyboard shortcut Ctrl + E. After
that, the dialog box Dictionary settings appears:

Dictignary setlings - 15t direction (German - English)

TR References | Font (Keyword list) |

Chaice 15t search direction

Language arss Al

Search direction  German - English
activedinactive o+ |I|

On the card Choice of book you can select and activate a
search direction. In the Chooser menus you can move the
cursor keys forwards and backwards. To see the whole
choice, tap the input field with the stylus.

Assuming that you want to create a new dictionary with the
search directions german-english and english-german. As
first direction select the language combination german-
english and activate it as mentioned above. Proceed
accordingly to select the search direction english-german as
second language combination:

Dictienary settings - 2nd direction (English - German)
Choice of bwklﬂafaranv;n]ﬁnt (Keyword list)]
[Shoice| 4 2nd search direction &
Language aroa ol
Search direction English - German
activeinactive + |I|

After fixing one of the search directions you have to define
the references of it.

Assuming you want to define the references of the second

search direction, that is english-german. Change to the card
References:

Dictionary settings - 1st direction (German - English)
[Choice of book | TIEIRE] Font (Keyword Fst)]

Keyword file  GerEng key

Dictionary file GerEng.at

User file GerEng.udb

Synonym file

DEEEE

[ Aarecten]
o= ]

18 e Dictionary functions TrueTerm EPOC
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In this case you have to define at least three files as
references.

Touch the

]

button on the right of each input line. The dialog box Assign
keyword file appears, for example:

Stichwortdatei zuordnen (=.key)

CELE o TrGerSpa.key >
Ordner Dokumente\TrueDic

Disk c

[ Durshsughen...| | Abbrechen | | oK |
Sirg+D

Here, enter the keyword file concerned, that you have
defined in the chooser menu.

Proceed in the same way with the dictionary file and the user
file. After you have defined at least these three files for each
book, the settings on the card References should roughly
look like this:

Dictionary setiings - st direction {(German - English)
Chaice of Boak Font (Keywerd Ii'II:IJ
Keyword file  GerEng.key

Dictionary file GerEng.ats
User file GerEng.udb

EQEEE

Fynanym file

Now you can exit the Dictionary settings by OK. Don’t
forget to save the dictionary settings at File — Save
dictionary.

If you want to create a dictionary that exclusively contains
your personal entries, please define only one user file of the
corresponding search direction but no keyword file or
dictionary file. Thus this dictionary will only contain user
entries.

A further option is to format the font of the keyword list.
Please select the card Font (Keyword list):

Dictionary settings - st direction (Garman - English)
| Choice of book] Rahramaslm—
Faont Arial
Size ] ]
Bold
Italic
Freview TreTemmn IE

The settings of the font will only be valid for the keyword list.

TrueTerm EPOC
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Data storage

Save data

The data storage is executed in an absolutely uncomplicated
way. With the software package PsiWin you can easily and
comfortably connect your desktop computer to your handheld
computer. You only have to call up the Psion-workstation on
your desktop computer. The software connects the two
computers. Now you can access files on your handheld
computer in the same way as with the Windows-Explorer.

To save the important Dictionary files of TrueTerm, go to
the directory TrueTerm. Copy all the files with the file
extension .udb on a storage medium of your choice, for
example the hard disk of the desktop computer. These files
are user-specific data you have captured on your handheld
computer. You have to save only these files because you
can retransfer the supplied dictionary files of TrueTerm
EPOC on your handheld computer (see: Installation,
Desktop computer->Psion) any time.

TrueTerm EPOCSync

The extended function of comfortable data exchange with
your desktop computer is provided by the supplementary
software TrueTerm EPOCSync. With this program you can:

» synchronize dictionaries, that is integrate dictionary
entries, which you have captured for example on your
desktop computer, in the dictionaries of the handheld
computer and vice versa,

* make easy dictionary backups;

* import keyword lists that you have already created on
the handheld computer.

After installation TrueTerm EPOCSync is automatically
integrated in your electronic dictionary system. The
synchronization of the dictionary data from the desktop
computer to the handheld computer and vice versa is
executed each time you call up the Psion-synchronization.

20 « Data storage
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If you want to acquire the TrueTerm EPOCSync please
contact directly the AlphaSoft company or send an e-mail to
sales@trueterm.com.

TrueTerm EPOC Data storage « 21



Service and hotline

Known problems

Problem:

In case you still use PsiWin 2.0 or any older version of
PsiWin, the icons that facilitate the installation of the
dictionaries from the desktop computer to the handheld
computer do not work.

Solution:

Call up the icon Add-On PsiWin 2.0 once after the
installation on the desktop computer. Then, the installation
can also be executed on the handheld computer running
Psiwin 2.0.

Support

For all problems and questions please contact the AlphaSoft
company (preferably via e-mail):

AlphaSoft

Production and distribution of software

Aldinger Strasse 86

D-70806 Kornwestheim

Germany

Owner: Mrs Sigrun Goellner

Hotline: + 49 (0) 7141/ 85 05 06
monday, tuesday 14:00-15:00 p.m.
wednesday — friday 15:00-16:00 p.m.

22 « Service and hotline
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Phone +49 71 54 /18 27 00
Fax +49 71 54 / 49 39
Homepage: vww.trueterm.com|
E-mail: [support@trueterm.com

Further information and support on Psion/EPOC is provided
on the homepage of the Psion company at
http://www.psion.com.

TrueTerm EPOC Service and hotline ¢ 23
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Appendix

Keyboard shortcuts

Ctrl + Del Delete all the entries in a History list.

Ctrl + E Call up the dialog box Dictionary settings. In this dialog you can
define the references to the user-defined dictionaries.

Ctrl +H Position the cursor in the Dictionary entry field and marks the
text inside.

Ctrl +1 Show the History list of the keyword list or the dictionary entry
depending on the position of the cursor.

Ctrl + K Position the cursor in the Keyword input field. A text, in case

or Esc there is one, will be deleted.

Ctrl + L Position the cursor in the Keyword list.

Ctrl + O Open the dialog box Open file. Now you can open a dictionary
that you have created yourself for example.

Ctrl + S Save the current changes made by the user.

Ctrl +Tab Tabulator-function inside the dictionary entry.

Ctrl + W Change to another search direction.

Tab Change to the next keyword and then to its dictionary entry.
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close 11

create 17
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settings 17
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Dictionary display

change 16
Dictionary entry 7, 14, 16

edit 14

save 14, 16

Dictionary files 10, 21

Dictionary options 12
set 12

Dictionary settings 10, 17, 20
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Drive letters 6, 12

E

Edit menu 14, 16
Enter key 6, 8, 12
EPOC32 4

Extras 6
Extrasbar 6
F

File menu 17
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Font/Paragraph button 14
set 14

H

History lists 9
Hotline 23
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Installation 4, 23

K
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delete 16
look up 7, 12
new 16
rename 16

Keyword file 19
assign 19
Keyword list 7, 12, 14, 17, 20

M

Memory card 7
Menu key 6
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Plus 16
Program files 4
Psion 24

Psion Series 3 4
Psion Series 5 4
PsiWin 21

PsiWin 2.0 23
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References to dictionary file
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S

Save button 14
Screen 4,9
Search direction 10, 18
change 10
Support 23
Symbols
graphic 12
Synchronization 21
System 5

T

Title bar (caption) 6, 12
Toolbar 10, 12, 16
blank 11, 13
show 12

Tools 12
Tools menu 12, 16

TrueTerm 3, 6, 11, 21
Start TrueTerm EPOC 6
TrueTerm EPOC 3, 6, 11
TrueTerm EPOCSync 21
TrueTermNet 3

U
User entries 11, 20

w

Windows 95/98 3
Windows CE 3
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